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q_id q_desc op1 op2 op3 op4 ans 
 

AXL1 
 
XML stands for   

Expansion 

Markup 

Language 

Expansion 

Makeup 

Language 

Extensible 

Markup 

Language 

EXtensible 

Makeup 

Language 

C 

AXL2 XML is a  Recommendation. W3C W1C W2C W4C A 
AXL3 XML is a language that is very similar to which language ? C HTML C++ JAVA B 

AXL4 DTD stands for  , which is called XML Schema. Direct to Direct 
Document Type 

Definition 

Data Type 

Definition 
Data to Data B 

AXL5 The extension of a XML document is  . (.xsd) (.xml) (.mlx) (.xlm) B 

AXL6 
To create a XML Map from XML schema, Go to which Tab in 

Excel  . 
Review Add-Ins Developer Data C 

AXL7 XML is case-sensitive ? TRUE FALSE   A 
AXL8 Excel works primarily with  types of XML files. 3 2 1 4 B 

AXL9 
What is the file extension of Schema file which contain schema 

tags ? 
(.xml) (.xsd) (.xlm) (.mlx) B 

AXL10 VBA stands for  . 
Visual Basic for 

Applications 

Visual Basic for 

Applets 

Visual Basic for 

Apple 

None of the 

above 
A 

AXL11 Macro enabled workbook file extension is    .xlsx .xlsm .xlsv .xlsw B 

AXL12 There are  ways to open a Macro enabled workbook. 3 2 4 1 A 

AXL13 ANOVA stands for   Analysis of Value Analysis of Varity 
Analog of 

Variance 

Analysis of 

Variance 
D 

AXL14 A function doesn’t require an argument is  . DATE() TODAY() MONTH() YEAR() B 

AXL15 
In Excel, there are  functions for calculation of 

depreciation. 
4 5 6 3 B 

 

 
 

AXL16 

 

 
SLN function used to calculate depreciation as 

per  . 

 
For calculation of 

depreciation as 

per Sum of Years 

Digit Method. 

 
For calculation of 

depreciation as 

per Straight Line 

Method. 

For calculation of 

depreciation as 

per Variable 

Declining Balance 

Method. 

For calculation of 

depreciation as 

per Double 

Declining Balance 

Method. 

 

 
B 
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AXL17 

 

 
SYD function used to calculate depreciation as 

per  . 

 
For calculation of 

depreciation as 

per Sum of Years 

Digit Method. 

 
For calculation of 

depreciation as 

per Straight Line 

Method. 

For calculation of 

depreciation as 

per Variable 

Declining Balance 

Method. 

For calculation of 

depreciation as 

per Double 

Declining Balance 

Method. 

 

 
A 

 
 
 

AXL18 

 

 
DB function used to calculate depreciation as 

per  . 

 

For calculation of 

depreciation as 

per Sum of Years’ 

Digit Method. 

 

For calculation of 

depreciation as 

per Straight Line 

Method. 

 

For calculation of 

depreciation as 

per Declining 

Balance Method. 

For calculation of 

depreciation as 

per Double 

Declining Balance 

Method. 

 

 
C 

 

 
AXL19 

 

DDB function used to calculate depreciation as 

per  . 

For calculation of 

depreciation as 

per Sum of Years’ 

Digit Method. 

For calculation of 

depreciation as 

per Straight Line 

Method. 

For calculation of 

depreciation as 

per Declining 

Balance Method. 

For calculation of 

depreciation as 

per Double 

Declining Balance 

Method 

 

D 

 

 
 

AXL20 

 

 
VDB function used to calculate depreciation as 

per  . 

For calculation of 

depreciation as 

per Variable 

Declining Balance 

Method. 

 
For calculation of 

depreciation as 

per Straight Line 

Method. 

 
For calculation of 

depreciation as 

per Declining 

Balance Method. 

For calculation of 

depreciation as 

per Double 

Declining Balance 

Method. 

 

 
A 

AXL21 PV Ratio stands for  . 
Point Volume 

Ratio 

Point Varaiance 

Ratio 

Profit Volume 

Ratio 

Profit Variance 

Ratio 
C 

AXL22 BEP stands for    Break Easy Point Break Even Point 
Balance Equal 

Point 
Break Equal Point B 

AXL23 Data Validation available in which Tab? Formulas Insert Data Developer C 

AXL24 
 function returns value from a given data range 

VLOOKUP() HLOOKUP() INDEX() LOOKUP() C 
based on row and column. 

AXL25 Which function categories are not available in Excel. Statistical Engineering Math & Trig Arts D 

AXL26 PMT Function is belongs to which categories of Excel function ? Text Logical Financial Math & Trig C 

AXL27 NPV stands for   
Net Present 

Value 
Net Proper Value 

Net Present 

Variance 

Negative Present 

Value 
A 
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AXL28   function uses a fixed rate to calculate depreciation DB VDB SYD SLN A 
AXL29 Which of them is not a Conditional Operators symbols? < </ <= <> B 

AXL30 
Strings are to be always enclosed in double quotes when used in 

a formula. 
TRUE FALSE 

  
A 

AXL31 Parentheses are used to change the order of calculation. TRUE FALSE   A 
AXL32 In Excel the function =Abs(-4) returns  . -4 2^2 4 None C 

AXL33 
 function returns the remainder after a number is 

DIVISOR() MOD() MODE() REMAINDER() B 
divided by a divisor. 

 

 
AXL34 

 

If User want to display the formulas rather than the results of the 

formulas then choose  . 

 
Formulas > 

Formula > Show 

Formulas. 

Formulas > 

Formula Auditing 

> Show 

Formulas. 

 
Formulas > 

Function > Show 

Formulas. 

Formulas > 

Formula Auditing 

> Function > 

Show Formulas. 

 

B 

AXL35 
 reveal about the current and future financial 

Report Data 
Financial 

statements 
None C 

condition of the company. 

AXL36 Which of them is a Intangible assets? 
Goodwill and 

Patents. 

Cash and 

Property. 

investment and 

securities. 

None of the 

above 
A 

AXL37 CR stands for  . Current Ratio Clear Ratio Current Rate Clear Rate A 
AXL38 QR stands for  . Quick Rate Quality Ratio Quality Rate Quick Ratio D 
AXL39 Debt – Equity Ratio =Long term debt / Shareholders funds. TRUE FALSE   A 

 
AXL40 

 
ACP stands for  . 

Average 

collection price 

Average 

collection 

payment 

Average 

collection period 

None of the 

above 
C 

AXL41 FATR stands for  . 
Fixed all turnover 

ratio 

Fixed assets test 

ratio 

Fair assets 

turnover ratio 

Fixed assets 

turnover ratio 
D 

AXL42 A  can be a numerical fact. Statistic Sale Salary Number A 
AXL43   stands for reduction in value of fixed assets. Depreciation Data Document Detail A 

AXL44 
Value of fixed assets is generally reduced over the period of time 

due to  . 
Wear & Tear 

Change in taste 

of people 

Change in 

technology 
All of the Above D 

AXL45 Profit equals to  . 
Purchase - Total 

Cost 
Sales - Total Cost 

Product - Total 

Cost 

Manufacturing - 

Total Cost 
B 
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AXL46 

 
Examples of fixed cost are  . 

Salary of 

administrative 

staff 

 
office rent 

 
Both A and B 

 
None C 

AXL47 
Cash budget is prepared for planning for future as far as 

movement of cash is concerned. 
TRUE FALSE 

  
A 

 
AXL48 

Discounting is not the process of determining the present value 

of a payment or a stream of payments that is to be received in 

the future. 

 
TRUE 

 
FALSE 

  

B 

AXL49 PAN must have  characters only. 8 10 11 12 B 
 

AXL50 

Sample means the units or items selected for study or 

consideration and population means the total set of data used 

for selection of samples. 

 
TRUE 

 
FALSE 

  

A 

 
AXL51 

  analysis relates items in the financial 

statements in a manner that drives out performance information 

about the company. 

 
Financial ratio 

 
Price 

 
Perodic 

 
Report A 

 
AXL52 

How to restrict to run a macro automatically when starting 

Microsoft Excel? 

Hold down the 

SHIFT key during 

start up. 

Hold down the 

CTRL key during 

start up. 

Hold down the 

ESC key during 

start up. 

Hold down the 

ALT key during 

start up. 

A 

AXL53 
Which option allows you to Bold all the negative values within 

the selected cell range? 
Zero Formatting 

Conditional 

Formatting 
Bold Formatting 

Negative 

Formatting 
B 

 
AXL54 

  allow us to perform calculations or operations 

that would otherwise be too cumbersome or impossible 

altogether. 

Cell referencing 

functions 

Absolute 

functions 

Worksheet 

functions 

Round( ) 

functions 
C 

AXL55 
Statistical functions in Excel help to calculate 

Arithmetic Mean Median Mode All of the above. D 

AXL56 Discounting Factor formula is    = n / (1+a) - r = 1 + (1/r) * n = 1 / (1+a) ^ 2 = 1 / (1+r) ^ n D 

AXL57 
 is considered as non cash expenditure and 

Cash Flow Depreciation Fund flow Expenditure B 
occupies a prominent place in Profit & Loss Account. 

AXL58 
The value which can be realized at the end of life of fixed asset 

by selling it is called    
Salvage Value cost life Factor A 

AXL59 
 is prepared for planning for future as far as 

Capital Budgeting Cash budget Both A& B Actual Budget B 
movement of cash is concerned. 

 
AXL60 

  is the process of determining the present value of 

a payment or a stream of payments that is to be received in the 

future. 

 
Marginal costing 

 
Capital Budgeting 

 
Discounting 

 
None C 
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AXL61 

  is one of the core principals of finance and is the 

primary factor used in pricing a stream of cash flows, such as 

those found in a traditional bond or annuity. 

 
Marginal costing 

 
Discounting 

 
PMT 

 
None B 

AXL62 XML schemas in Excel are called XML  . Schemas Maps Elements Markups C 
 

AXL63 

Excel allows us to use various functions and even simple 

mathematical calculations which can be used for 

  . 

 
Financial analysis 

 
Equity analysis 

Leasing decisions 

and the list goes 

on 

 
All of Above D 

AXL64 
Which cell reference show the reference to other sheet or 

reference to other workbook in excel ? 
Sheet2!C4 Sheet2{C4} Sheet2(C4) Sheet2<C4> A 

AXL65 Which of them is not a Range References? A1:A4 $A$1:A4 A1, A2 , A3, A4 A$1:A$4 C 

AXL66 Interest Coverage Ratio equals to  . 
EBIT / Debt 

interest 

EIBT / Debt 

interest 

ETIB / Debt 

interest 

EBTI / Debt 

interest 
A 

AXL67 
If particular workbook have to open each time Excel started, 

where the workbook should be placed? 
AUTOEXEC folder 

AUTOSTART 

folder 

EXCELSTART 

folder 
XLSTART folder D 

 

AXL68 

 

If the cell B1 contains the formula=$A$1, which of the statement 

is true ? 

There is a 

relative 

reference to cell 

A1 

There is an 

absolute 

reference to cell 

A1. 

Further changes 

in value of A1 will 

not affect B1. 

Further changes 

in value of B1 will 

not affect A1. 

 
B 

 
AXL69 

  is a computerized mathematical technique that 

allows people to account for risk in quantitative analysis and 

decision making. 

Finanical 

Planning 

Monte Carlo 

Simulation 

Corporate 

Planning 

Personal Finance 

Planning 
B 

AXL70 
 is the process of meeting the financial goals through Corporate 

planning 

Monte Carlo 

simulation 

Financial 

planning 

Personal Finance 

planning 
C 

the proper management of finances. 

 
AXL71 

  can be defined as the process of setting the 

procedures in the organization for achieving the predefined 

goals. 

Monte Carlo 

Simulation 

Corporate 

Planning 

Decision Tree 

Analysis 

Corporate 

Planning & 

Analysis 

B 

 
AXL72 

  shows ability of company to pay back long term loans 

along with interest or other charges from generation of profit 

from its operations. 

 
Debt Assets Ratio 

Interest 

Coverage Ratio 

Total Fund 

Ration 

None of the 

above 
B 

 
AXL73 

 
is the simplest method of comparing Earnings Per 

share 

Fixed Asset Over 

ratio 

Price Earnings 

Multiple 

 
Gross Profit Ratio C 

different stocks at a point of time to make investment decisions. 
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AXL74 

 

The very first line of code of XML file is  . 

<?xml 

version="3.0" 

encoding="ISO- 

8859-1"?> 

<?xml 

version="2.0" 

encoding="ISO- 

8859-1"?> 

<?xml 

version="1.0" 

encoding="ISO- 

8859-1"?> 

<?xml 

version="0.0" 

encoding="ISO- 

8859-1"?> 

 
C 

AXL75 Every bit of data has to start and end with an identical tag 
<TagName>Data 

</TagName> 

</TagName>Data 

<TagName> 

</TagName>Data 

</TagName> 

<TagName>Data 

<TagName> 
A 

 
AXL76 

 
The exact syntax of PMT function is  . 

PMT(nper, rate, 

pv, [fv], [type]) 

PMT(rate, nper, 

pv, [fv], [type]) 

PMT(rate, pv, 

nper, [fv], [type]) 

PMT(pv, rate, 

nper, [fv], [type]) 
B 

 
AXL77 

 
The exact syntax of IPMT function is  . 

IPMT(rate, nper, 

pv, [fv], [type]) 

IPMT(pv, rate, 

per, nper, [fv], 

[type]) 

IPMT(per, rate, 

nper, pv, [fv], 

[type]) 

IPMT(rate, per, 

nper, pv, [fv], 

[type]) 
D 

 

AXL78 

 

To see the XML Map user must go  . 

 

Developer>XML> 

Source 

 

Developer> 

Source 

File       

Menu>Options>A 

dd in>Excel Add 

In>XML 

 

None of the 

above. 

 
A 

AXL79 Deletion of XML Map  is done through  . 
Directally Delete 

Command 
Delete Button 

XML Maps Dialog 

Box 

None of the 

above 
C 

AXL80 Method of tax calculations shall change according to  . Annual Income DOB status of assess All of the above. D 

 
AXL81 

 
EMI stands for  . 

Easy Monthly 

Installment 

Equating 

Monthly Income 

Equal Monthly 

Installement 

Equated monthly 

installment 
D 

AXL82 
Which function is used to calculate the principal portion in every 

installment ? 
IPMT PPMT PMT 

None of the 

above 
B 

 
AXL83 

  is a process used in statistical analysis in which a 

predetermined number of observations will be taken from a 

larger population. 

Snowball 

sampling 

 
Sampling 

Systematic 

sampling 

Simple random 

sampling 
B 

AXL84 
In  , Individuals are selected at regular intervals from 

a list of the whole population. 

Clustered 

sampling 
Sampling 

Systematic 

sampling 

Simple random 

sampling 
C 

 
AXL85 

In  each individual is chosen entirely by chance 

and each member of the population has an equal chance, or 

probability, of being selected. 

Snowball 

sampling 

Convenience 

sampling 

Systematic 

sampling 

Simple random 

sampling 
D 

AXL86 
Which method is commonly used in social sciences when 

investigating hard to reach groups? 
Quota Sampling Sampling 

Snowball 

sampling 

Simple random 

sampling 
C 
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AXL87 
 are useful for quick reading and easy understanding, 

Balance sheet Summary reports IRR NPV B 
particularly for top management. 

 
AXL88 

It is a process in which a business determines whether projects 

such as building a new plant or investing in a long-term venture 

are worth pursuing. 

Business 

Investment 

 
Capital Budgeting 

Capital 

Investment 

Investment 

management 
B 

AXL89 
Popular methods of capital budgeting include  and 

payback period. 

discounted cash 

flow 

internal rate of 

return 
net present value All the above D 

AXL90 
 is the value of all future cash inflows less future cash Net present 

value 
Working capital IRR PMT A 

outflows as on today. 

 
AXL91 

  is the process of defining and analyzing the dangers 

to individuals, businesses and government agencies posed by 

potential natural and human-caused adverse events. 

Sensitivity 

analysis 

 
Risk analysis 

Qualitative risk 

analysis 

 
Scenario analysis B 

AXL92 
 which is used more often, does not involve Sensitivity 

analysis 
Risk analysis 

Qualitative risk 

analysis 
Scenario analysis C 

numerical probabilities or predictions of loss. 

 
AXL93 

  are generally used to present information in a simple 

and better way and also be used to analyse the risk in a better 

way. 

 
Graphs 

 
Sparklines 

 
Both A& B 

 
Charts D 

 
AXL94 

It is a technique used to determine how different values of an 

independent variable will impact a particular dependent variable 

under a given set of assumptions. 

Decision Tree 

analysis 

Sensitivity 

analysis 

 
Both A& B 

 
Neither A &B B 

 
AXL95 

  involves computing different reinvestment rates for 

expected returns that are reinvested during the investment 

horizon. 

 
Scenario analysis 

Sensitivity 

analysis 

Decision Tree 

Analysis 

 
None A 

AXL96 NPER stands for   
Total Principal 

Value 
Net Per value 

Total Interest 

Value 

Number of 

Periods 
D 

AXL97 
Which function that is used to calculate the payment for specific 

loan terms    
SUMIF() PMT COUNTIF() 

None of the 

above 
B 

AXL98   helps to break down the Return on Equity Du Point Analysis 
Return on 

Investment 

Profitability 

Ration 

None of the 

above 
A 

AXL99 
 is a common method for financing property, facilities, 

Mortagage Leasing Rent All the above B 
and equipment. 

 
AXL100 

 
Find the correct sequence in case of XML file, are 

Structure, store, 

and transport 

information. 

Store, structure, 

and transport 

information. 

Structure and 

store 

information. 

Store and 

transport 

information. 

A 
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AXL101 
Programming of Macros is done in programming Language 

  . 
VBA ASP.Net Java C++ A 

AXL102 
As Bank auditors,Many Banking applications generate text files in 

  . 
Txt format Csv format Both A and B Nither A Nor B C 

 
AXL103 

 
Macro security is enabling through  . 

 
Not Required 

Developer 

tab>Code>Macro 

Security 

Developer 

tab>Modify>Mac 

ro Security 

Developer 

tab>Controls>Ma 

cro Security 
B 

AXL104 In Excel, Sampling option is available in  . Insert Data Analysis View None B 
 
AXL105 

 
Requirements for preparation of cash budget in Excel. 

Knowledge of 

accounting 

Knowledge of 

formatting an 

excel sheet 

Knowledge of 

cell linking & 

basic formulae 

Knowledge of all 

of the above. 
D 

AXL106 ROE stands for  . Recall on Equity Return on Equity 
Return on 

Enquary 

Return of 

Equalisation 
B 

 

AXL107 

  is a statistical procedure that uses sample evidence 

and probability theory to determine whether a statement about 

the value of a population parameter should be rejected or should 

not be rejected. 

 

Confidence 

Interval 

 

Hypothesis 

 

ANOVA 

 

None of the 

above 

 
B 

AXL108 
 is a statistical tool used to create predictive Regression 

equation 
Regression 

Multiple 

Regression 
Single Regression C 

models. 

AXL109 
 shows the ability of a company to pay its current 

Quick Ratio Current Ratio Liquidity Ratio Solvency Ratio C 
financial obligations. 

AXL110 
 shows dependency of a firm on outside long term 

Quick Ratio Leverage Ratio Liquidity Ratio Solvency Ratio B 
finance. 

AXL111 
To record a Macro in relative mode,"Üse Realtive References" 

available in which tab of excel ? 
Developer Tab View Tab Both A and B Nither A Nor B C 

 
AER1 

An  is a group of people with a common goal, 

having certain resources at its disposal to achieve the common 

goal. 

 
Company 

 
Enterprise 

 
Organization 

 
Concern B 

AER2 
 include money, manpower, materials, 

Costing Production Sales Resources D 
machines, technologies etc. 

 
AER3 

  is a collection of activities that make one or more 

kinds of input and creates an output that is of value to the 

customer. 

 
Business Model 

Business 

Function 

 
Business Process 

Business 

Operation 
C 
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AER4 

Information systems can be designed so that accurate and timely 

data are shared between functional areas. These systems are 

called  . 

Integrated 

Information 

Systems 

Isolated 

Information 

Systems 

Non-Integrated 

Information 

Systems 

Non-Isolated 

Information 

Systems 

A 

 
AER5 

The approach to ERP is to first develop a                   

comprising the business processes or activities that are the 

essence of a business. 

 
Business Model 

Business 

Function 

 
Business Process 

Business 

Operation 
A 

AER6 OLAP stands for  . 
Online Analysis 

Processing 

Online Analytical 

Processing 

Online Analytical 

Programming 

None of the 

above 
B 

 
AER7 

  is a tool that refers to skills, processes, 

technologies, applications and practices used to facilitate better, 

accurate and quicker decision making. 

Data 

Warehousing 

 
Data Modeling 

Business 

Modeling 

Business 

Intelligence 
D 

 
AER8 

Business Intelligence Systems are data-driven 
  

.
 

Information 

Systems 

Integrated 

Information 

Systems 

Decision Support 

Systems 

Non-Isolated 

Information 

Systems 

C 

ACS9 Finacle developed by    Infosys HCL Technologies TCS I-Flex A 

ACS10 Flexcube developed by    Infosys HCL Technologies TCS I-Flex D 

ACS11 Quarz developed by    Infosys HCL Technologies TCS I-Flex C 

ACS12 
The server is a sophisticated computer that accepts service 

requests from different machines which are called   
Clients Customers Party IP A 

ACS13 
 server has to be a powerful and robust system as it 

Antivirus Server 
Application 

Server 
Web server Clients Server B 

has to perform all the core banking operations. 

 
ACS14 

 
ATMS stands for   

Automatic 

Telephone 

Machine 

Automated Teller 

Machine Server 

 
Auto Machanic 

 
Allow to Machine B 

 

ACS15 

 

IBAS stands for    

Internet Business 

Application 

Server 

Internet Banking 

Application 

Server 

Internet Banking 

Application 

software 

Internet Business 

Authenticatin 

server 

 
B 

ACS16 PBF stands for   
Positive Balance 

File 
Post Balance File 

Positive Balance 

File 

Positive Balance 

Flex 
C 

ACS17 
Internet banking refers to a banking transactions routed through 

the    
Bank Internet Intranet Net banking B 
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ACS18 

 

CPPD Stands for  . 

Computer 

Planning and 

plant 

department 

Computerized 

Planning and 

Policy 

Department 

 

Both A &B 

Computer 

Planning and 

Policy 

Department 

 
D 

ACS19 
The  is generally a hardware and it plays the role of 

preventing unauthorized access. 
Date base Server Web server Proxy Firewall D 

ACS20   enable data transmission over different networks. Switches Firewall Routers Middleware C 

ACS21 
 have many ports that are connected to different 

Router Switches Firewall Middleware B 
systems and it facilitates data transmission with the network. 

ACS22 A Proxy server always acts in conjunction with a  . Firewall Internet Antivirus None A 

ACS23 
The  provides network security by preventing malicious 

data from entering the network. 
ATM Server Proxy Server Date base Server Web server B 

ACS24   is used for authentication. System audit 
system 

administration 

Domain 

Controller 
Network security C 

ACS25 Access to a set of servers is controlled by the  . System audit 
system 

administration 
Librarian 

Domain 

Controller 
D 

ACS26   is a process of unauthorized entering a network. 
Data base 

administration 
Hacking Routors Thrashing B 

 
ACS27 

  facility provides a customer to access financial 

transactions in a public place. 

Automatic tele 

Machine 

Automated Teller 

Machine 

Automated 

Technical 

Machine 

Accelereated 

Teller machine 
B 

 
ACS28 

 
Which is the Function of ATM? 

 
Cash Withdrawal 

 
Balance Inquiry 

Registering 

requests for 

Cheque book 

 
All the above D 

ACS29 Every bank branch should madatorily have a security policy. FALSE TRUE   B 

ACS30 The Operational Controls include controls on    Physical Access Logical Access 
Environmental 

Controls 
All of the above D 

ACS31 
Application Controls are broadly classified into 

Input Controls Output Controls 
Processing 

Controls 
All of the above D 

ACS32 
 controls check that the data entered is complete and 

Input Controls Output Controls 
Processing 

Controls 
All of the above A 

correct. 

ACS33 Reasonableness check is a  . 
Processing 

Controls 
Input Controls Output Controls 

Management 

Control 
B 

ACS34 Which of the following is not a module of the CBS? 
Customer ID 

generation 

Accounts 

management 

Equity Share 

management 
Clearing Module C 
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ACS35 

 
Bank guarantees can be    

Performance 

Guarantee 

Deferred 

Payment 

Guarantee 

 
Both A & B 

None of the 

above 
C 

ACS36 SLR stands for    
Statutory 

Liquidified Ratio 

Statutory 

Liquidity Ratio 

Standard 

Liquidity Ratio 

Stable Liquidity 

Ratio 
B 

ACS37 
 are record of activities that have taken place in the 

Logs Index Activity Logs 
None of the 

above 
A 

system irrespective of the modules. 

ACS38 The contents of a log includes    
Activity 

performed 
User details Date and Time All of the above D 

ACS39 
Communication and Operations management must include 

which policies? 
E-mail policy 

Firewall security 

policy 
Internet policy All of the above D 

ACS40 
Logs of the various activities in CBS can be deleted immediately 

and also be accessed by anybody. 
TRUE FALSE 

  
B 

 
ACS41 

 
CRR stands for  in terms of CBS. 

Cash Reserve 

Ratio 

Community 

Reserve Ratio 

Cash Reversal 

Ratio 

Cash Reimbursed 

Ratio 
A 

ACS42 
Does the IS Audit also include audit of the outsourcing activites 

carried out in the CBS system? 
Yes No 

  
A 

 
ACS43 

 
DRP stands for  in terms of CBS. 

Disaster 

Recovery 

Planning 

Discovered 

Resources 

Planning 

Disastrous 

Recovery 

Planning 

Disaster 

Recording 

Planning 

A 

ACS44 
 are soultions applied when any kind of 

Patches Logs Access Rights 
None of the 

above 
A 

vulnerabilities discovered in networks in the CBS system. 

ACS45   can be viewed only by the DBA of an organisation. 
Access Rights 

Logs 
Database Log 

Operating 

System Log 
Activity Log B 

ACS46 
Is performing periodic vulnerability assessment of the networks 

is necessary? 
Yes No 

  
A 

ACS47 
KYC stands for  in terms 

banking. 

Know Your 

Customer 

Know Your 

Company 

Know Your 

Connection 

Know Your 

Centre 
A 

ACS48 
In CBS, the Accounts Management module deals with Creation of 

Savings Account 

Creation of 

Current Account 
Overdraft All of the above D 

ACS49 Soft copy of the ATM journal rolls is called   Stock Journal Journal Report 
Electronic 

Journal 
All of the above C 

ACS50 The ATM switch consists of a    computer server Both A & B 
None of the 

above 
C 
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ACS51 
 testing should be done to check the 

Penetration Hierarchical Top down Bottom up A 
unauthorised access to the network in CBS. 

ACS52 
 enables transfer of money from one bank to another 

EFT NEFT RTGS 
None of the 

above 
C 

in "Real time" and on "Gross" basis. 

ACS53 
In  system money transfers are done on a one to one 

basis while in  system transfer is done in batches. 
NEFT, RTGS RTGS,NEFT EFT,RTGS 

None of the 

above 
B 

ACS54 
All the money transfers take place in the books of the 

Beneficiary bank Central bank(RBI) Remitting bank 
None of the 

above 
B 

ACS55 EFT and NEFT work on  basis DNS HSM SSM All of the above A 

ACS56 
 system of money transfer is primarily used for large 

NEFT RTGS EFT All of the above B 
transactions. 

ACS57 
In RTGS, the STP generates an  for every outbound 

RTGS transaction. 
UTN UTE UTR UTS C 

 
ACS58 

UTR full form  in terms 

of CBS. 

Unique 

Transaction 

Reference 

Unidentified 

Transaction 

Reference 

Unique 

Transmission 

Reference 

None of the 

above 
A 

 
ACS59 

STP stands for  in terms of 

CBS. 

Straight Through 

Processing 

Straight 

Temporary 

Processing 

Strict Through 

Processing 

None of the 

above 
A 

 
ACS60 

CMS stands for  in terms of 

CBS. 

Control 

Management 

System 

Cash 

Management 

System 

Core 

Management 

System 

Centre 

Management 

System 
B 

 
 
 

ACS61 

 
 
 

Which of the following statements is true? 

 

Audit of internal 

controls is not 

needed at all 

Systems audit 

are important for 

the verification 

of the internal 

controls 

Audit of controls 

in any banking 

environment is 

performed using 

software audit 

 

 
None of the 

above 

 

 
B 

 

ACS62 

 

The Management Controls does not include    

 

Managing of 

Assets 

 

Formulating a 

security policy 

Developing a 

business 

continuity 

planning 

Laying down 

procedures for 

system 

development 

 
A 

ACS63 
 is supported by advanced technology infrastructure and 

Firewall Internet banking 
Core Banking 

Solution 
Web centre C 

has high standards of business functionality. 

ADB23 Which type of joins not available in Access 2010? Inner join Left outer join Right outer join Full join D 
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ADB24 
A join returns only those rows from both tables that match on 

the joining field is  in MS Access 2010. 
Inner join Left outer join Right outer join Full join A 

 
ADB25 

The query returns all of the rows from left table, and also those 

rows from the right table that is known as  . 

 
Right outer join 

 
Left outer join 

 
Inner join 

None of the 

above 
B 

 
ADB26 

The query using  returns all the rows from right 

table, and also those rows from the left table that share a 

common value on both sides of join. 

 
Right outer join 

 
Left outer join 

 
Inner join 

None of the 

above 
A 

 
ADB27 

 
How can we add a table to the Query Design window  ? 

Select Create-> 

Add Table 

Select Database 

Tools-> Add 

Table 

Select Design -> 

Show Table 

Select the table 

from navigation 

Pane. 
C 

ADB28   can be considered a questions in a data base. Queries Form Reprt Macro A 
ADB29 Operands can be  in MS Access 2010. Literals Identifiers Function All D 

ADB30 In example "Hello"+" " +" everyone" ,hello is    Text Literal Date Literal Number Literal 
None of the 

above 
A 

ADB31 
Length("Ms Access") will return the count of charcters is 

  . 
9 8 7 6 A 

ADB32 AND ,OR is a kind of  in MS-Access 2010. Arithmetic Logical Comparision 
None of the 

above 
B 

ADB33 
Comparision operators is also known as  in MS-Access 

2010. 
Arithmetic Logical Relational 

None of the 

above 
C 

ADB34 LIKE operator works with  in MS Access 2010. Text Date Both A and B 
None of the 

above 
C 

 
ADB35 

 
IN operator is used  in MS Access 2010. 

To match the 

value to a set of 

values 

To find the null 

records of given 

table 

returns true or 

false 

None of the 

above 
A 

ADB36 
Operator precedence is similar to  that is follwed in 

Algebra in MS-Access 2010. 
BODMAS BOMDAS BODSAM 

None of the 

above 
A 

AER9 
 technology is the process of creating and Data 

Warehousing 
Data Modeling 

Business 

Modeling 

Business 

Intelligence 
A 

utilizing the company's historical data. 

 
AER10 

  can be defined as subject-oriented, integrated, 

time-variant, non-volatile collections of data used to support 

analytical decision making. 

 
Data Models 

Data 

Warehouses 

 
Data Mines 

 
Operational Data B 
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AER11 

  databases contain detailed data that is 

needed to satisfy processing requirements but which has no 

relevance to management or analysis. 

 
Operational 

 
Non-Operational 

 
Subject-Oriented 

 
Informational A 

AER12 
Data in the Data Warehouse is  , not 

  . 
Dynamic, Static 

Non-Volatile, 

Static 
Volatile, Static Static, Dynamic D 

AER13 
 data contains an historical perspective that is not Operational, 

Informational 

Operational, 

Static 

Informational, 

Static 

Informational, 

Operational 
D 

generally used by the  systems. 

 
AER14 

The definition of data elements in the data warehouse and in the 

data sources and the transformation rules that relate them, are 

referred to as  . 

 
Masterdata 

 
Detaileddata 

 
Metadata 

 
Basedata C 

AER15 
Data warehouses are not the optimal environment for 

  data. 
Structured Unstructured Informational Operational B 

AER16 Maintenance Costs are high for Data Warehousing. TRUE FALSE   A 

AER17 Data Warehousing can be used for  . 
Credit Card 

Churn Analysis 

Insurance Fraud 

Analysis 

Logistics 

Management 
All of the above D 

AER18 
 is the process of extracting patterns from 

Data Analysis 
Data 

Warehousing 
Data Mining Data Modeling C 

data. 

 
AER19 

  is an approach to quickly answer multi- 

dimensional analytical queries. 

Business 

Processing 

Management 

Online Analytical 

Processing 

Product Life 

Cycle 

Management 

Supply Chain 

Management 
B 

AER20 
The Output of an OLAP query is typically displayed in a 

  format. 
Matrix Columnar Stepped Outline A 

AER21 
 companies is planning to support tens of 

B2B B2C C2B C2C B 
millions of customers with just hundreds of employees. 

 
AER22 

 
Which of the following is the limitation of Open Source ERP? 

Increased 

Complexities 

Legal 

Complexities 

Unsuitable for 

conventional 

applications 

 
All of the above D 

AER23 Which of the following is not an Open ERP software? Openbravo SQL-Ledger Open-Project ERP5ERP C 
 

AER24 

 
is the process of integrating all the business functions and  

EDI 
 

ERP 
 

BPM 
None of the 

above 
B 

processes in an organization to achieve numerous benefits. 

 
AER25 

  must consider the fundamental issues of system 

integration by analyzing the organization's vision and corporate 

objectives. 

 
Manager 

 
Auditor 

Top 

Management 

Commitment 

 
Either A or B or C A 
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AER26 
The more the number of  , the longer the 

implementation time. 
modules process package units D 

AER27 
Customization of ERP systems is one of the major challenges in 

auditing ERP security. 
TRUE FALSE 

  
A 

AER28 
Tally.ERP 9 provides graphical analysis of data which helps the 

user to perform deeper analysis. 
TRUE FALSE 

  
A 

AER29 
The user can  the company data into multiple 

companies as per financial periods required. 
Import Export Split Backup C 

AER30 
E-Filing of Returns refers to the process of electronically filing 

your tax returns through the  . 
Intranet Internet Extranet Any of the above B 

 
AER31 

Tally.ERP 9 does not allows you to export the ETDS forms in NSDL 

compliant formats as well as facilitates printing of TDS Forms in 

Physical Form. 

 
TRUE 

 
FALSE 

  

B 

AER32 
Tally.ERP 9 offers a data encryption option called 

  . 

Tally Data 

Encryption 

Tally Data 

Encoding 
Tally Vault 

Tally Data 

Conversion 
C 

AER33 
 is the process of exchanging Tally.ERP 9 

Serialization Randomization Synchronization Asynchronization C 
data between two or more locations. 

 
AER34 

The Tally website offers  , by which a user can 

communicate with a Tally representative and get required 

information. 

 
Tally Forum 

 
Tally FAQ 

 
Tally Support 

 
Tally Chat D 

AER35 
Tally.NET use  for centralised Account 

Management. 
Data Centre Control Centre Cloud Centre 

Administration 

Centre 
B 

 
AER36 

The data is transferred between the remote location and the 

server using a secured mechanism called  . 

 
Encoding 

 
Decoding 

 
Encryption 

 
Decryption C 

AER37 Sales Tax Ledger falls under which Group? Indirect Expenses Duties and Taxes Sales Purchases B 

AER38 Alias represents  in Tally.ERP9. Short name Nickname Code name All of these D 

AER39 
If we purchase any Fixed asset in credit, we can pass it from 

  . 
Payment mode Receipt mode Journal mode Contra mode C 

 
AER40 

To save entry without any amount, we have to use 

  . 

 
Cost Center 

Maintain 

Multiple godown 

Allow 0 value 

entry 

 
Use Rej Notes C 

AER41 
Transfer of materials from one godown to another godown, use 

  . 

Manufacturing 

Journal 
Stock Journal Purchase Journal Both A & B B 
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AER42 
While exporting Ledgers from Tally to Web Page, we use 

  . 
XML Format ASCII Format SDF Format HTML Format D 

AER43 Budget represents  . Estimation Forecasting Assumption All of these D 

AER44 
In Service tax Credit Adjustment (%) should be either 

  . 
0.2 1 Both A & B Neither A &B C 

 
AER45 

 
Service Tax Report can be seen from  . 

Display > Day 

Book 

Display > 

Account Books 

Display > 

Statutory 

Masters 

Display > 

Statutory 

Reports 
D 

AER46 Can we allow Expenses/Fixed Assets in Purchase vouchers? Yes No   A 

AER47 
Transfer from Main Cash to Petty Cash we require to pass 

  voucher. 
Payment Contra Receipt None of these B 

AER48 Income Tax number of the Company will appear in which report? Cash/Bank Book 
Profit and Loss 

A/c 
Reminder Letter None of these D 

AER49 A business model is not a  model. system mathematical Conceptual Logical B 

AER50 
OLAP systems use concept of OLAP cube called a 

  cube 

single 

dimensional 

hyper 

dimensional 

multi 

dimensional 
none C 

AER51 
The data which is to be exported from Tally.ERP 9 can be in 

  format. 
XML HTML ASCII ALL D 

AER52 In Tally ERP-9 Remote Access is also known as  . Networking VB.Net Tally.Net 
None of the 

above 
C 

AER53 
Accessing data store on a remote location using Internet in 

Tally.ERP9 is called  . 
Local Data Remote Data Internet Data 

None of the 

above 
B 

AER54 
Tally.ERP9 can be classified user in two categories 

are  . 
Local User Remote User Both A & B 

None of the 

above 
C 

AER55 
Which of the following is not a predefined security level provided 

by Tally.ERP 9? 
Owner Public User Data Entry Tally.NET User B 

AER56 
The business model is represented in the graphical form using 

  and    
charts, pictures smart art, clip art 

flowcharts, flow 

diagrams 
graphs, shapes C 

 
 

 
AER57 

 
 

 
Which of the following is/are the data warehousing activity? 

Identifying and 

prioritizing 

subject areas to 

be included in 

the Data 

Warehouse 

 

Defining the 

correct level of 

summarization to 

support business 

decision making 

Establishing a 

data warehouse 

help desk and 

training users to 

effectively utilize 

the desktop tools 

 
 

 
All of the above 

 

 

D 
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AER58 

  is the succession of strategies used by 

management as a product goes through its life cycle. 

Business 

Processing 

Management 

Online Analytical 

Processing 

Product Life 

Cycle 

Management 

Supply Chain 

Management 
C 

AER59 
 integrates supply and demand mangement within and 

BPM SCM PLM CRM B 
across companies. 

AER60 
 includes transportation from Suppliers and receiving Inbound 

Operations 

Outbound 

Operations 

Sourcing 

planning 

Production 

planning 
A 

inventory. 

AER61 Which of the following is not the service area of SCM? Logistics 
Asset 

Management 
PLM CRM D 

AER62 
Which step of the ERP implementation involves, educating and 

recruiting end users throughtout the implementation process? 
Step 1 Step 2 Step 3 Step 4 B 

 
AER63 

The system  process will address issues such as 

software configuration, hardware acquisition and software 

testing. 

 
implementation 

 
upgradation 

 
installation 

 
migration C 

 
AER64 

A  review is recommended to ensure that 

all business objectives established during the planning phase are 

achieved. 

pre 

implementation 

under process 

review 

post 

implementation 

None of the 

above 
C 

 
AER65 

In  stages, auditors have access to 

rudimentary ERP tools and capabilities for auditing security 

configurations. 

post 

implementation 

pre 

implementation 

 
Both A & B 

 
Either A Or B A 

AER66 
Immediate posting and updation of books of accounts as soon as 

the transactions are entered.  This is called as    

Interactive 

Processing 

Immediate 

Processing 

Real Time 

Processing 

Business 

Processing 
C 

 
AER67 

 
Which of the following ETDS forms are available in Tally.ERP 9? 

Form 26, 

Annexure to 26 

Form 27, 

Annexure to 27 

Form 26Q, 

Annexure to 26Q 

 
All of the above D 

 
AER68 

The exported eTDS file from Tally.ERP 9 can be validated through 

NSDL's freely downloadable utility called    

File Validation 

Program 

File Validation 

Utility 

File Valuation 

Program 

File Valuation 

Utility 
B 

AER69 ERP systems provide an access to the  data integrated distributed isolated de-centralized A 

AER70 
Business intelligence systems are  Decision Support 

Systems. 
data-driven 

information 

driven 
resource driven none A 

AER71 
Data warehousing technology is the process of creating and 

utilizing the company’s    
general data historical data operational data none B 

AER72 
The data in the Warehouse comes from the    

environment and external sources. 
operational backup data none A 
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AER73 
In essence, SCM integrates  management within 

and across companies. 

supply and 

demand 
supply and chain 

supply and 

sortage 
none A 

AER74 
 including all fulfillment activities, warehousing Inbound 

operations 

outbound 

operations 

hybridbound 

operations 
none B 

and transportation to customers. 

AER75 
Customer Relationship Management is a    

level strategy. 
business corporate strategic none B 

AER76 
Operational CRM provides support to  business 

processes. 
front office back office staff none A 

 
AER77 

Collaborative  ultimate goal is to use information 

collected by all departments to improve the quality of services 

provided by the company. 

 
CRM's 

 
ERP 

 
SCM 

 
none A 

AER78 
Tally.ERP 9 follows the DES  method to safeguard the 

data. 
encryption decryption cryptography none A 

AER79 
Immediate posting and updation of books of accounts as soon as 

the transactions are entered.  This is called as    

Interactive 

Processing 

Immediate 

Processing 

Real Time 

Processing 

Business 

Processing 
C 

 
AER80 

 
Which of the following ETDS forms are available in Tally.ERP 9? 

Form 26, 

Annexure to 26 

Form 27, 

Annexure to 27 

Form 26Q, 

Annexure to 26Q 

 
All of the above D 

 
AER81 

The exported eTDS file from Tally.ERP 9 can be validated through 

NSDL's freely downloadable utility called    

File Validation 

Program 

File Validation 

Utility 

File Valuation 

Program 

File Valuation 

Utility 
B 

 

AER82 

With  technology the characters are reduced in 

breadth and user is allowed to input additional characters which 

would make the account name, entity complete and readable. 

 

Tally Fix 

 

Tally Adjust 

 

Tally Fit 

 

Tally AutoFit 

 
C 

 

AER83 

In Tally.ERP 9  provides the user with 

administrator rights and the capability to check the entries made 

by the authorised users and alter these entries, if necessary. 

 

User-defined 

Security 

 

HTTP-XML based 

data interchange 

 

Unlimited multi- 

user support 

 

Audit Feature 

 
D 

 
AER84 

  is an enabling framework which 

establishes a connection through which the remote user can 

access the Client's data without copying/transferring the data. 

Direct Web 

Browser Access 

 
Web Publishing 

 
Tally.NET 

 
Email facility C 

 
AER85 

If we want the company to be connected automatically for 

remote access on load, the property  needs to be set 

it as Yes. 

Allow to Connect 

Company 

 
Contact On Load 

 
Either A or B 

None of the 

above 
B 
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ACS1   is centralized Banking Application Software. 
Core Banking 

System 

Core Banking 

Solution 

Complete 

Banking Solution 

Centralized 

Banking Solution 
B 

ACS2 
 has several components which have been designed to 

CBS CSB NEFT None A 
meet the demands of the banking industry. 

ACS3 
Core Banking Solutions is a combination of an application 

software and    
Network devices Firewall IBAS IBDS A 

ACS4 
 is a large data housing infrastructure that provides high 

ATM Server Data Centre IT EDP B 
band width access to its clients. 

ACS5 Data centre servers are known as  . 
Application 

servers 

Data Base 

Servers 
Web server All the above D 

ACS6 
 is a method of creating virtual networks within a 

VLAN LAN WAN MAN A 
physical network. 

ACS7 
Data communication between  VLANs can be controlled 

as per business requirements. 
1 2 3 4 B 

ACS8 Bank mate is developed by the    Infosys HCL Technologies TCS I-Flex B 

ACS64 
CBS Software resides in a Central application server which is 

located in the    
ATM Data centre Middleware Web centre 

Central Office 

Data Centre. 
D 

 
ACS65 

A  that runs the core banking solutions (CBS) and is 

centrally accessed by the branches. 

 
ATM Server 

Central 

Application 

Server 

 
Database Server 

Domain Name 

Server 
B 

ACS66 
The  of the application is capable of only entering the 

data at the end point that is branches. 
System version 

Application 

Version 
Client version Firewall C 

ACS67 
The application server would be placed in a trusted inside zone in 

a separate    

Virtual Local Area 

Network 

Local Area 

Network 

Wide Area 

Network 

Personnal Area 

Network 
A 

ACS68 Application software would access the    Data base server 
ATM DATA 

Server 

Domain Name 

Server 

Application 

Server 
A 

ACS69 
 are capable of being connected only when devices 

LAN Virtual Networks MAN WAN B 
are connected to a switch. 

 
ACS70 

A special feature of STP is that  number for any 

outbound RTGS transaction is generated by the STP System. 

Unique 

Transation 

Referrence 

 
PIN NO 

Uniform 

Transaction 

Reference 

 
None C 
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ACS71 

  refers to the process of developing software 

which would produce the required output from the input 

provided of course, using the necessary hardware and 

communication systems. 

 
Application 

Development 

 
Software 

Development 

 
Server 

Development 

 
System 

Development 

 
D 

 
ACS72 

The  is essential to ensure that computer security 

records are stored in sufficient detail for appropriate period of 

time. 

Review 

Management 

 
RTGS 

 
Log management 

Authorized 

Controller 
C 

 

 

 

 
 

ACS73 

 

 

 

 

 
Which of the following is “False“ in case of penetration testing in 

an IT environment of CBS? 

 

 
 

is a legal attempt 

at gaining access 

to protected 

computer 

systems or 

networks. 

 

 

 
 

Ensure 

recoverability of 

data in case of 

system failure. 

 

 
The purpose of 

the test is to 

identify security 

vulnerabilities 

and then attempt 

to successfully 

exploit them. 

This is often the 

most preferred 

test as it is an 

accurate 

simulation of 

how an 

outsider/hacker 

would see the 

network and 

attempt to break 

into it. 

 

 

 

 
B 

 

 

 
ACS74 

 

 
 

Which of the following is erroneous statement in case of Change 

Management Control? 

 

Unit test, system 

test, integration 

test – all should 

be carried out. 

Well   

documented 

process should 

be there 

incorporating all 

the changes. 

 

Implement new/ 

changed 

programme as 

per schedule. 

It is important 

that correct 

latest version of 

programe is used 

but version 

number need not 

be changed. 

 

 

D 

 

ACS75 

 

With respect to the customer changing the Pin at the ATM which 

procedure is the ”false“ procedure? 

Old offset value 

used to derive 

new PIN. 

 

Old Pin verified 

using HSM/SSM. 

Natural Pin 

remains the 

same. 

Old offset value 

erased and new 

offset value 

generated. 

 
A 

ACS76 
IN CBS, changes to the application server are not made directly 

to it, instead done first on a    
Trail server Validate server Test Server 

None of the 

above 
C 

ACS77 
All the various servers in the central data centre are seggregated 

through    
LANs VLANs WANs MANs B 
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ACS78 

The  is a complete process in the computer so that it 

ensures that data that is fed in conforms to certain prerequisite 

conditions. 

 
Consalidation 

 
Password Policy 

 
protection 

 
Validation D 

 

ACS79 

When the central Data base is busy with central end of day 

activities or for any other reason, the file containing the account 

balance of the customer is sent to the ATM switch. Such a file is 

called    

 

Positive Balance 

File 

 

Application 

Server 

 

Centralised Data 

base security 

 

Central Office 

Data Centre. 

 
A 

ACS80 The IBDS is located in a    Militarised zone City Zone State zone 
demilitarised 

zone 
D 

ACS81 
The main components of Internet Banking system consist of 

Web server IBAS IBDS All the above D 

 
ACS82 

Copy of the Anti Virus Software was updated promptly and 

regularly at the Data Centre and pushed into all of the servers 

and in all the systems in the branches by    

 
Hacking Method 

Push-pull 

method 

 
Both A &B 

None of the 

Above 
B 

ACS83 
The  which is also residing in the server at the branch 

actually does the banking operations. 
Sytem software utility software 

Application 

Software 

Application 

Server 
C 

 
ACS84 

In Core Banking concept all the systems of the bank are 

connected to the Central office by means of a connectivity which 

may be either a  or a dial up line. 

 
local line 

 
Leased line 

 
Broadband 

 
None B 

 
ACS85 

The  is generated by the software and directly sent to 

equipment for printed the Pin Mailer. 

 
16 digit number 

Personal 

Identification 

Number 

Net transaction 

ID NO 

 
ATM No B 

 
ACS86 

  would also include the existence of built in 

controls in the system to ensure proper processing of input data 

so as to provide the required output. 

 
Output Control 

 
Input control 

 
Process Control 

 
Data Control C 

ACS87 
 refers to an arrangement wherein the issuing bank 

Letter of Credit Letter of Tax Letter of Payable 
Letter of 

Receible 
A 

acts on the request and instructions of a customer. 

 
ACS88 

  is a process by which the bank ensures the 

maintenance and recovery of operations. 

Business 

Recovery 

Planning 

Business 

Continuity 

Planning 

Disaster 

Recovery 

Planning 

 
None B 

ACS89 
At which phase of testing the version of software is called “ beta 

version”? 

Programmer 

testing 
User testing (a) & (b) both None of above C 
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ACS90 

 
In an Organization structure of IT Department which of the 

following function is incompatible? 

Database 

Administrator 

and Security 

Administrator. 

Network 

administrator 

and Database 

Administrator. 

Network 

Administrator 

and Security 

Administrator. 

Tape Librarian 

and database 

administrator. 

 
B 

ACS91 
The number that is stored in the ATM switch is the difference of 

which of the following number? 

Pin No - offset 

value 

Offset value - Pin 

No 

Pin No - Natural 

Pin 

Offset Value - 

Natural Pin 
C 

 
ACS92 

The information retrieval of transactions taking place at ATM 

located at remote locations is through    

Soft copy of 

Electronic journal 

Hard copy of 

Electronic 

Journal 

 
Cash register 

 
(a) and (b) both A 

ACS93 
The number that is generated as soon as the customer inserts 

the card in the ATM machine is    
Offset value 

Pin sent to 

customer 
Natural Pin Card Number C 

ADB1 Which is not a Database management system. Unix Oracle Sybase Foxpro A 

ADB2 
The  operator is used to find the null records in a 

table. 
"= NULL" NULL IS NULL All of the Above C 

ADB3 
When you create relationship between two tables, the Common 

field's data type should be 
Text & Number Number & Text 

different data 

type 
Same data type D 

 
ADB4 

 
SQL stands for  . 

Sub Query 

Language 

Structured Query 

Language 

Structured 

Question 

Language 

System Query 

Language 
B 

ADB5 
MS Acces 2010 reads and writes to the .accdb file format in 

chunks also known as  . 
Pages Encrypt pages Base Database 

None of the 

above 
A 

 
ADB6 

 
DDL stands for    

Data Definition 

Language 

Data Defined 

Language 

Detailed 

Definition 

Language 

Data Detailed 

Language 
A 

 
ADB7 

 
DML stands for    

Detailed 

Maintaining 

Language 

Data Maintaining 

Language 

Data 

Manipulation 

Language 

Detailed 

Manipulation 

Language 

C 

ADB8 Whenever a tables gets update, the dependent query will Not update 
update 

automatically 

have to update 

manually 
never update B 

ADB9 
To extract the records based on date field, which of the symbol 

should be used 
$ # () " " B 

ADB10 The data can be entered into a table in the  view. Design Datasheet Dataview All of the Above B 

ADB11 In a Query the data can be sorted based Single column Multiple columns Both A and B 
None of the 

above 
C 
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ADB12 
When you create a field using text data type in MS Access 2010, 

by default field will have  character. 
255 256 258 128 A 

 
ADB13 

If we are using the same table for main query and sub-query,we 

need to provide  . 

Alternate names 

to the tables 

No need to 

alternate name 

to the tables 

Aliases name to 

the tables 

 
Both A and C. D 

ADB14 
Update Query can be used to update  in MS Access 

2010. 
Single Record 

More than 1 

record 
Both A and B 

None of the 

above 
C 

ADB15 Delete Query can be used to delete Single Record 
More than 1 

record 
Both A and B 

None of the 

above 
C 

ADB16 How many Primary key constraints can create in a table  . Only one Two As many All of the Above A 

ADB17 
Unmatched Query can help to find records that have no 

corresponding reord in other tables. 
FALSE TRUE 

  
B 

 
ADB18 

MS Access 2010 provides queries that can be used for obtaining 

the aggregated results instead of individual records 

are  . 

 
Sum() 

 
Count() 

 
Avg() 

 
All of the above D 

ADB19 
A function that Counts the set of values that satisfy the given 

criteria in MS Access 2010 is  . 
CountA() Count() Countif() All of the above B 

ADB20 Aggreagate Query also known as  . Group By queries Total query Action query Both A and B D 

ADB21 Which Query wizard is used to find repeated records in a table? 
Simple Query 

Wizard 

Duplicate Query 

Wizard 

Cross table 

Query Wizard 
All of the Above B 

ADB22 
Append Query is used to  in a table in MS 

Access. 
Add Records Delete Records View Records Update Records A 

 

ADB82 

 

How does a query-based report differ in design to a report based 

on just one table? 

 

The reports are 

restricted in size. 

 

It doesn’t 

It doesn't have as 

many design 

options. 

The only report 

type available is 

the Design 

Report. 

 
B 

 
ADB83 

How would you include some plain text into a mailing label 

report? 

Type the text 

directly into the 

label. 

 
Use the > button. 

Use the Mailing 

label wizard text 

option. 

Use the >> 

button. 
C 

ADB84 
In a Microsoft Access 2010 report, the page numbering would 

most likely be placed into the: 
Report Footer Section Header Page Footer Page Header C 
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ADB85 

If you wished to present a professionally looking form on screen 

that would show all the necessary information, which of the 

following form design tools would you most likely use? 

 
Pivot Table 

 
Pivot Chart 

All The tools of 

the form design 

control gallery. 

Form Wizard 

Columnar 
C 

 

 
 

ADB86 

 

 
What are the benefits of an ACCDE 

file  in Access 

 

 
Reduces the size 

of the database 

 

Optimizes 

memory usage 

and improves 

performance. 

Protects the VBA 

code from being 

viewed or edited 

while still 

allowing it to run. 

 

 
 

All of the above 

 

 
D 

ADB87 
An .ACCDE file is a  version of the original .ACCDB 

file. 
Fixed-down Locked-down Open-down 

None of the 

above 
B 

ADB88 
Which type of the query is used to accept the value from the 

user while executing the query and fetch records accordingly 

Make Table 

Query 
Update Query Delete Query Parameter Query D 

ADB89 
To encrypt the databse in Access 2010 must be opened in the 

  . 

Open Secure 

mode 

Open Inclusive 

mode 

Open Exclusive 

mode 
Open Read Mode C 

ADB90 FIX() is a kind of  function in MS-Access 2010. Math Date Text 
None of the 

above 
A 

ADB91 
MS-Access 2010 has added new features of  to eliminate 

the need of VBA code 
Macro Form Report 

None of the 

above 
A 

ADB92 
Encrypting a database does not restrict access to database 

objects, but to  the database. 
Open Modify Read Write A 

 
 

 
ADB93 

 
 
 

The setting for the Security option can be handled 

using  in Access 2010. 

File Tab ->New 

Options, and 

selecting the 

Trust Centre tab 

from the Access 

Option window 

File Tab ->Access 

Options, and 

selecting the 

Trust Centre tab 

from the Access 

Option window 

File Tab - 

>Security 

Options, and 

selecting the 

Trust Centre tab 

from the Access 

Option window 

 
 
 

None of the 

above 

 

 

B 

ADB94 
Third Party Encryption Technology can also be applied to the 

database of Microsoft Access 2010. 
TRUE FALSE 

  
A 

ADB95 To create a split database in MS Access 2010 go to which tab? Create Tab External Tab File tab Database Tools D 

ADB96 
After spliting database,frontend database 

holds  . 
Forms Query Report All of the above D 

ADB97 
After spliting database,backend database 

holds  . 
Tables Forms Query Report A 
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ADB98 

 
When an Access database is split, it creates two 

files  . 

A back-end 

database & front- 

end database 

 
A new database 

& Old database. 

primary database 

& secondary 

database 

 
None of the 

above 

 
A 

ADB99 
A Data Access Page is a special type of  that allows 

users to interface with database using Internet Explorer. 
XML page HTML Page Web page 

None of the 

above 
C 

ADB100 
MS Access provide  datatype to create link to a web 

page,file,or email address. 
Link Hyperlink Insert Attached B 

 

ADB101 

 

To make a switchboard appear while opening the database. 

Set as database 

startup Option in 

Access Option 

Set as Form 

startup Option in 

Access Option 

Set as 

Switchboard 

startup Option in 

Access Option 

 
None of the 

above 

 
C 

ADB102 
To add or delete buttons to Switchboard, which option is used in 

Switchboard Manager is used. 
Add Option Edit Option Modify Option Build Option B 

ADB103 
The Switchboard Manager is a dialog box that allows creating a 

switchboard for an Access database. 
TRUE FALSE 

  
A 

ADB104 A macro can automate data entry in Access 2010. FALSE TRUE   B 

ADB105 Which of the following data-type is not available in MS-ACCESS Text Number AlphaNumeric Date C 

ADB106 
The validation can be defined at  level in Access 

2010 
Table Form Both A and B Report C 

ADB107 
A macro can be attached to an event of a 

control  . 
A form A report A button All of the above D 

 

 

 

 

ADB108 

 

 

 

 

How to add switchboard in Access 2010? 

Click->File tab- 

>Option Button- 

>Quick Access 

Toolbar- 

>Command not 

in Ribbon- 

>Switchboard 

Manager->Add- 

>OK 

 
Click->File tab- 

>Option Button- 

>Command not 

in Ribbon- 

>Switchboard 

Manager->Add- 

>OK 

 
Click->File tab- 

>Option Button- 

>Quick Access 

Toolbar- 

>Switchboard 

Manager->Add- 

>OK 

Click->File tab- 

>>Quick Access 

Toolbar- 

>Command not 

in Ribbon- 

>Switchboard 

Manager->Add- 

>OK 

 

 

 
A 

 
ADB109 

The command Design Application performed 

action  on switchboard. 

Close the current 

database 

Opens a 

secondary 

switchboard. 

Opens the 

Switchboard 

Manager. 

Opens a report in 

Print Preview. 
C 
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ADB110 
Switchboard Manager only allows a maximum of 

  command buttons on a switchboard 
Nine Eight Seven Six B 

 
ADB111 

MS Access 2010 provides a  pane that contained large 

list of actions to be chosen,enabling a wide range of commands 

that can be performed 

 
Action List 

 
Action Catalog 

 
Action query 

 
Action Box B 

ADB112 SQL is considered to be a    2GL 3GL 4GL 
None of the 

above 
C 

ADB113 
Which action in MS Access macro applies a fliter or query to a 

table,form or report. 
DoFilter FindFilter ApplyFilter UseFilter C 

ADB114 
Opens a query in the Datasheet view, Design view, or Print 

Preview which macro action used in MS Access. 
OpenQuery ShowQuery RunQuery FindQuery A 

ADB115 
Among +, <>, MOD, AND, <= operator which operator has the 

highest priority. 
+ MOD AND <> B 

ADB116 The Strcomp() function is a  type function. Math Financial Text Date & Time C 
ADB117 The SGN() function is a  type function Math Financial Text Date & Time A 
ADB118 Which of the following symbol is used to write a sub query [] () {} # B 

ADB119 
For the Non-Aggregate Total field, the criteria can only be 

specified using the Where clause. 
TRUE FALSE 

  
A 

 

ADB120 

 

To export an access table to an XML File, which of the below 

steps must be followed? 

Right-click the 

table and select 

Export ->XML 

Go to External 

Data ->Export, 

click on More 

and select XML 

Right-click the 

table and select 

send as XML 

 

Both A and B 

 
A 

ACA1 
In IDEA, import Assistant wizard is used to import data 

from  . 
Excel Access XML All of the above D 

 
ACA2 

 
What is the procedure for importing data into IDEA ? 

File->Import 

Assistant-> 

Import to IDEA 

File->Import -> 

Import to IDEA 

File->Import as -> 

Import to IDEA 

File->Select 

Import -> Import 

to IDEA 

A 

 
ACA3 

 
IDEA exports data in a number of  . 

 
text 

 
database 

spreadsheet and 

mail merge 

format 

 
All of the above D 

 
ACA4 

In IDEA,Data Extraction select data form a file for 

further  for creating a new file of logically selected 

records. 

 
Extraction 

 
Recording 

 
Investigation 

 
Sorting C 

ACA5 
What is step by step procedure for using Bendford's law function 

in IDEA ? 

Data->Benford's 

Law 

Analysis- 

>Benford's Law 

Sampling-> 

Benford's Law 

Tools->Benford's 

Law 
B 
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ACA6 

 

 
 
 

A Benford's Law analysis is most effective on 

data  . 

 

 
 

Comprised of 

similar sized 

values for similar 

phenomena. 

 

 

 
Without built-in 

minimum and 

maximum values. 

 
Without assigned 

numbers, such as 

bank accounts 

numbers and zip 

codes and with 

four or more 

digits. 

 

 
 

 

All of the above 

 

 

 
D 

ACA7 In IDEA, blank value data can be extracted by using  . @isblank() as Null Null Is Null A 

ACA8 
In IDEA, Summarization, Pivot Table, Stratify, Duplicate Key 

functions comes under which menu. 
Data Analysis Sampling Relation B 

ACA9 
In IDEA, Extraction, Sort, Indices, Search functions comes under 

which menu. 
Analysis View Relation Data D 

ADB37 
Text files that are organized properly fall into one of two types 

are   
Delimited files Fixed-width files Both A and B 

None of the 

above 
C 

ADB38 
To create an unmatched Query using wizard, minimum required 

number of table or fields is  . 
one two three four B 

ADB39 While creating the query, the criteria can be set in Only one 
More than One 

Field 
As many field All of the Above D 

ADB40 
In MS Access query which logical operator returns True if both 

the expressions compared are true. 
IF AND AND Both AND LIKE AND B 

ADB41 
In MS Access query which logical operator returns True if either 

of the expressions compared are true. 
OR IF OR IS OR LIKE OR A 

ADB42 
Enfore Referencial Integrity option is used to restrict enerting 

data in 
Parent Table Child Table Any one table All of the Above B 

ADB43 In MS Access left("Access",3) function will return  . Acc3 Acc 3Acc ess B 

ADB44 
Which function is used to converts the text to lower case in MS 

Access 2010. 
Lcase() Lowercase() Lower() 

None of the 

above 
A 

ADB45 
Which function is used to remove leading or trailing spaces in a 

text in MS Access 2010. 
Remove() Removetext() Trim() 

None of the 

above 
C 

ADB46 
 is contains a set of predefined functions in MS Expression 

Design 

Expression 

Builder 
Expression Box 

Expression 

elements 
B 

Acccess and helps build complex expression. 

ADB47 Which of the following is a Database Software Excel Outlook Oracle C++ C 
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ADB48 

 

 

 
Which of the following is not the characteristics of a Relational 

Table? 

Each Table row 

represents a two- 

dimensional 

structure 

composed of  

rows and  

columns 

 

 
Each row/column 

intersection 

represents a 

single data value 

 

The order of the 

rows and 

columns is 

immaterial to the 

DBMS 

 

Each column has 

a specific range 

of values known 

as the Tuple 

domain 

 

 

 

D 

 
ADB49 

 
Which record will be retrieved if the query criteria is < #1/1/11#? 

All values less or 

more than 1,195 

Value less than 

95 characters 

Records with 

date before 2011 

 
All of above C 

ADB50 
The tab in Expression Builder in which we write expressions is 

known as  . 

Expression 

Elements 
Operator Button Expression Box 

Expression 

Builder window 
C 

 

ADB51 

 

The criteria expression LIKE?B*. 

Will match all 

text starting from 

B 

Will match all 

text ending from 

B 

Will match all 

text having 

second character 

as B 

Will match all 

text starting with 

a digit 

 
A 

ADB52 
 queries are useful for summarizing information, and 

Select query Crosstab query Action query Parameter query B 
are somewhat similar to pivot tables in MS-Excel. 

ADB53 
While entering record in Datasheet view, in which order the 

records can be entered 

Alphabetical 

Order 

At the end of the 

table 

Any where in the 

table 

Beginning of the 

table 
B 

ADB54 
When you delete the record in form, it deletes the record 

from  . 
Form only 

Form but not in 

table 

Table but not in 

Form 
Form & Table D 

ADB55 Having clause is used in the aggregate query in MS Access 2010 FALSE TRUE   B 

ADB56 
The controls that are not linked to any field of the table or query 

on the form are known as  . 
ActiveX control 

Unbounded 

Controls 
Graphics Control Bound Controls B 

ADB57 
Which property of the form can be used to insert a background 

image in MS Access 2010? 
Caption Background Record Source Picture D 

ADB58 
 is a report that is inserted in another report in MS 

Inner-Report Sub-Report Inside-Report Insert-Report C 
Access 2010. 

 
ADB59 

A bound main report is based on a  and its 
  

contain realted information. 

Table or 

query,Inner- 

Report 

Table or 

query,Main- 

Report 

Table or 

query,Sub- 

Report 

None of the 

above 
C 

ADB60 
A  used to compare multiple values of categories or 

differences over a period of time. 
Pie Chart Area Chart Bar Chart Column Chart D 
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ADB61 A  used to compare trends over a period of time. Pie Chart Line Chart Bar Chart Column Chart B 

ADB62 
To create a read-only copy of the database, which of the 

following file format can be used? 
.ACCDB .ACCDE .MDW .ACCDT B 

 
ADB63 

The database administrator created a split database and created 

a front-end database and back-end database file.Which of the file 

should be stored on the server ? 

Front-end 

database 

Back-end 

database 

 
Both of them 

 
None of them B 

 

 
ADB64 

 

To make database package and digitally sign using which option 

in Access 2010 ? 

File- 

>Save&Publish- 

>Save Database 

as->Package and 

sign 

File->New->Save 

Database as- 

>Package and 

sign 

File->Save as- 

>Save Database 

as->Package and 

sign 

File- 

>Save&Publish- 

>Save Object as- 

>Package and 

sign 

 

A 

ADB65 
In which formats can the Collect Data through email message 

feature can send the data entry form? 

HTML and 

InfoPath 
Access Forms 

Visual Basic 

Application 
Excel attachment A 

 
ADB66 

Once a mail is sent using the collect data through email message 

feature in Access 2010. The mail status can be checked 

using  . 

Export to 

Outlook 

Options in Tool 

menu of Access 

 
Manage replies 

 
All of the above C 

ADB67 
The  type of data cannot be collected using Collect 

data through email messages. 
Text Number Date/time AutoNumber D 

 

ADB68 

 

What is the memo data type field used for? 

 

To add table 

To store objects 

created in other 

programs 

 
For long text 

entries 

For shout text 

entries of no 

more than 255 

characters 

 
C 

 

ADB69 

 

The filter By selection feature allows you to filter: 

Those records 

that match an 

entity in a field 

Records based 

on a criterion 

you specify 

Records that 

meet any of 

several criteria 

you specify 

 

All of above 

 
A 

ADB70 Which editor was provided for use with Access Basic? 
The Visual Basic 

1.0 editor 
Notepad 

The QuickBasic 

editor 
All of above B 

 

 
ADB71 

 

How do you update Pivot Table report data after changes are 

made to the source data? 

Save your 

changes, close 

the workbook, 

and then reopen 

it. 

Select the Pivot 

Table worksheet 

and press F9 on 

the keyboard 

Click the report, 

and on the Pivot 

Table toolbar, 

click the refresh 

data button 

 

 
All of the above 

 

C 

ADB72 What are the different views to display a Table ? Datasheet View Design View 
Pivote Table & 

Pivot Chart View 
All Of Above D 
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ADB73 
Which Of The Following Creates A Drop Down List Of Values To 

Choose From? 
Ole Object Hyperlink Memo Lookup Wizard D 

ADB74 
A  Enables You To View Data From A Table Based On 

A Specific Criterion 
Form Query Macro Report B 

ADB75 
The Database Language That Allows You To Access Or Maintain 

Data In A Database 
DCL DML DDL None Of Above A 

 

ADB76 

 

DCL Provides Commands To Perform Actions Like 

Change The 

Structure Of 

Tables 

Insert, Update Or 

Delete Records 

And Data Values 

Authorizing 

Access And Other 

Control Over 

Database 

 

None Of Above 

 
C 

ADB77 Which is not a Database Model ? 
Network 

Database Model 

Relational 

Database Model 

Object Oriented 

Database Model 

Structureed 

Database Model 
D 

ADB78 Which Of The Field Has Width 8 Bytes? Memo Number Date/time Hyperlink C 

ADB79 
This Is The Stage In Database Design Where One Gathers And List 

All The Necessary Fields For The Database Project. 
Data Definition Data Refinement 

Establishing 

Relationship 

None Of The 

Above 
A 

 
ADB80 

The Third Stage In Designing A Database Is When We Analyze Our 

Tables More Closely And Create A  Between Tables 

 
Relationship 

 
Join 

 
Query 

 
None Of These A 

 

 
ADB81 

 

What is the purpose of the Switchboard Manager in Microsoft 

Access 2010? 

To build a main 

switchboard 

form that 

controls all other 

forms. 

Creates the 

macros used to 

program an 

automatic 

application. 

To allow the user 

to switch from 

one database file 

to another. 

To allow 

changing from 

one report to 

another. 

 

A 

 
 
 

ACA46 

 
 
 

Which of the following is a benefit of using CAATs? 

 

 
File an FIR based 

on audit finding 

 

Identify an audit 

finding w.r.t. 

materiality in an 

IT environment 

 

Investigation of 

fraud in audit 

area 

To give 

assurance to 

customers about 

the performance 

of the company 

 

 
B 

AOA1 Is there a fixed qualification for internal auditor  . TRUE FALSE   B 
 

AOA2 

  refers to use software/applications to 

automatically perform tasks such as accounting,preparing trial 

balance, financial statements etc. and electronically transmit 

data or information using internet.. 

 

ERP 

 
Office 

automation 

 

Either A or B 

 
None of the 

Above 

 
B 
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AOA3 

  , , are commonly referred to 

as CIA in information security parlance. 

Confidentiality,In 

tegrity and 

Availability 

Confidentiality,In 

tegrity and 

Authentication 

Confidentiality,In 

tegrity and 

Access rights 

Confidentiality,In 

tegration and 

Authentication 

A 

 
AOA4 

 
means information available in the organization  

Confidentiality 
 

Integrity 
 

Availability 
 

Authentication B 
should not be altered or modified by unauthorized personnel. 

AOA5 
The process of identifying an individual, usually based on user id 

and password in an organization is called  . 
Availability Authentication Confidentiality Integrity B 

 
AOA6 

Which of the following is not a software equipment required in a 

CA's office? 

Resource 

allocation and 

scheduling 

Client 

management 

 
HR and Payroll 

None of the 

Above 
D 

AOA7 Which of the following is not an application arranged by ICAI? ICAI-XBRL suite K-DOC 
Billing and 

Accounting 
ICAI-TOC D 

AOA8 How many stages are there in the sales cycle? 2 3 4 5 B 
 

AOA9 
 
PBX stands for    

Private Exchange 

Branch 

Public Exchange 

Branch 

Private Branch 

exchange 

Public Branch 

exchange 
C 

AOA10 
Which of the following will not appear in the home page of K- 

Doc? 
Powerpoint Word Paste Document My Templates C 

 
AOA11 

To change an email header so that the message appears to have 

originated from someone or somewhere other than the actual 

source is known as  . 

Email middle 

attack. 

 
Email Spoofing. 

 
Email hacking. 

 
Email tracking B 

AOA12 To playfully satirize a website is known as  . Web tapping Web Interception Web spoofing Web threating C 

 
AOA13 

  is the complete package to manage the billing 

requirements of a CA firm on cash system of accounting. 

 
Payroll 

 
eSecretary 

Billing and 

Accounting 

software 

K-DOC 

application 
C 

AOA14 Which of the following is not a/an feature of eSecretary? 
Contact 

Management 

Greeting 

Management 

Email 

Management 

Share certificate 

printing 
D 

AOA15 Annual return preparation can be done using  . 
ICAI-ROC 

application 

K-DOC 

application 

ICAI XBRL 

Software 
Payroll A 

AOA16 
 is correspondence automation & management K-DOC 

application 
eSecretary 

ICAI XBRL 

Software 

ICAI-ROC 

application 
B 

software that is seamlessly integrated with Microsoft Office. 
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AOA17 

  is an independent,objective assurance and consulting 

activity designed to add value and improve an organization's 

operations. 

 
Statutory audit 

 
Tax audit 

 
Internal auditiing 

None of the 

Above 
C 

AOA18 
Which of the following is/are the main purpose of the internal 

audit? 

Financial 

reporting 

Operations of the 

organization 
Both A and B Either A or B C 

 
AOA19 

As per  of the Income tax Act,every person 

carrying on business or profession is requires to get his accounts 

audited by a CA before the "specified date". 

 
Section 45 

 
Section 44AD 

 
Section 43B 

 
Section 44AB D 

 

AOA20 

 

FEMA Stands for  . 

 
Foreign Exports 

Management Act 

Financial 

Enterprise 

Management Act 

 
Foreign Exchange 

Managament Act 

 
None of the 

Above 

 
C 

 
AOA21 

Which application helps the management to allocate the revenue 

to the credit of the right employee who identified the 

opportunity? 

Resource 

allocation and 

scheduling 

Knowledge 

management 

Document 

Management 

Systems 

Client 

management 
D 

AOA22 Who has full privileges in the financial accounting application? 
Database 

administrator 

Account 

administrator 

System 

administrator 

User 

Administrator 
C 

 
AOA23 

  is the centre point of the financial accounting 

application as any transactions having financial impact carried 

out in any other module will reflect in this module. 

 
AP module 

 
GL module 

 
AR module 

 
FA module B 

AOA24 
In Financial Accounting Application,the transactions flow from GL 

(General ledger) to other modules. 
TRUE FALSE 

  
B 

 

AOA25 

 

Which of the functionalities is not provided in the purchasing 

module of Financial Accounting Application. 

 

Evaluation of 

Vendors 

 

Receipts of 

goods or service 

Invite and 

analyze 

quotations from 

vendors 

 

Comparison with 

budgets 

 
D 

 

AOA26 

In Financial Accounting Application,automatic sequence number 

of documents control is not required in which of the following 

module? 

 

Purchasing 
 

Accounts Payable 
Expense 

Management 

 

Fixed assets C 

AOA27 
Which module of Financial Accounting Application can be used 

for assigning credit limit to customers? 
Purchasing Sales Accounts Payable 

Accounts 

Receivable 
B 

AOA28 Which of these will trigger/alert for timely payment ? Accounts Payable 
Accounts 

Receivable 

Expense 

Management 

Bank 

Reconcilations 
C 
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AOA29 

We can manage interviews,offers and job vacancies by using 

which of the application? 

Resource 

allocation and 

scheduling 

HR and Payroll 

applications 

Knowledge 

management 

None of the 

Above 
B 

 
AOA30 

  provides information about updation of project 

cost based on time spent by employees on various projects. 

Performance 

management 

system 

HR management 

system 

 
Payroll 

Timesheet 

application 
D 

 

AOA31 

 

Which of the follwing is not a/an functionality provided by PMS? 

Capture the Key 

Performance 

Indicators 

Employee 

designation and 

reporting 

structure 

Automated alerts 

for pending 

appraisals 

Prepare 

summary or bell 

curve analysis of 

all employees 

 
B 

 

AOA32 

  automates the calculation of salary for taking inputs 

from the timesheet application, leaves from Leave Management 

System and salary details from the HR master data. 

 

Timesheet 

System 

 

HR management 

System 

 

Payroll System 

Knowledge 

management 

System 

 
C 

 
AOA33 

Which of the follwing is not a control in Leave Management 

System? 

Reduce 

administrative 

burden on HR 

 
Excess leave 

Error free 

capture of leave 

details 

Approval 

workflow 
C 

AOA34 
Permanent Audit File are obtained once but updated on 

  basis. 
half-yearly yearly monthy quarterly B 

 

 
AOA35 

 

In Permanent Audit file,  is not the key data 

documented. 

 

Organization 

chart 

 

Client’s 

accounting 

manual 

Copies of clients’ 

incorporation 

documents like 

MoC 

Copies of 

important 

contracts or long 

term lease 

agreements 

 

C 

 

AOA36 

 

The Document Management Sytem offers the 

features  . 

 

Role based 

access 

 

Complete audit 

trail 

Cost effective to 

maintain the 

documents in 

soft copy 

 

All the Above 

 
D 

AOA37 
 is a type of training in which user logon on the training 

Internal Training E-Learning 
Classroom 

Training 
E-Training B 

server with a user ID and password. 

AOA38 
In some cases, trainee is supposed to appear for the 

examination/test at the end of the training is  . 

Classroom 

Training 
E-Learning Virtual Learning All the Above B 

AOA39 
 are the hardware/infrastructure equipments used in a 

PC 
Application 

Server 
WAN All the Above D 

CA firm. 
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AOA40 
Which of these is/are the standard email program used in an 

organization? 

Microsoft 

Exchange 
Lotus Notes Both A and B 

None of the 

Above 
C 

 

AOA41 

 

Which of the following is not a characteristics of WAN? 

Most WANs are 

owned by only 

one organization. 

Compared to 

LAN, its 

transmission 

speed is low 

 

WAN uses only 

private networks. 

Switches are 

used to connect 

LAN and WAN 

 
B 

AOA42 
 is protection of information assets from threats to 

Confidentiality Integrity 
Information 

Security 

None of the 

above 
C 

preserve their value. 

AOA43 
Which types of information assets need to be secured in a CA 

Office? 
Client data Own data Own documents All the above D 

AOA44 
The extent and level of  would depend on the nature 

of information. 
Availability Confidentiality Integrity Authentication B 

AOA45 
 of information might be affected due to denial of 

Integrity Authentication Confidentiality Availability D 
service attack or some other reasons. 

AOA46 
 means the sender cannot deny having sent a 

Non-Repudiation Integrity Authentication Confidentiality A 
message and receiver cannot deny receiving the message. 

AOA47 Risk may not be  in nature. reputational financial operational vulnerable D 

ACA10 In IDEA, Append functions can be used to  . Import data 
Add data at the 

end 
Sort Filter B 

ACA11 In IDEA, Statistics functions can be applied on  . Numeric Data Date Data Both A and B 
None of the 

above 
C 

ACA12 
In IDEA, increment value in Stratification function can be fixed or 

free interval. 
FALSE TRUE 

  
B 

ACA13 In IDEA, Stratified Random functions is a part of which menu. Analysis Data Relation Sampling D 
ACA14 Which of the following is not an Audit Software ACL IDEA Unix SOFTCAAT C 

ACA15 
Using which functions to perform more complex calculations and 

exception testing in IDEA? 
Equation Editor function Editor 

Calculation 

Editor 
Testing Editor A 

 

 

 
ACA16 

 

 

 
Which is the step by step procedure for reporting in IDEA. 

 

 
 

File->Print- 

>Create Report 

 

Click on Create 

Report button on 

the Operation 

toolbars->Report 

Assistant. 

 

 

 
Both A and B 

 

 
File->Select 

Export -> Print 

Report. 

 

 

C 
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ACA17 
Which of the following are categories of computer audit function 

? 

Items of audit 

interest 
Data Analysis 

System 

validation 
All of the above D 

ACA18 In the following list which is not an audit function ? Sorting Filtering Sampling Export D 
ACA19 In the following list which is a audit function? File Definition Stratification Print Preiview Append B 

 
ACA20 

Which is the following step involved in a source code review 

methodology ? 

Review 

Programming 

standards 

Understand 

program 

specifications 

Formulate flaw 

hypotheses 

 
All of the above D 

ACA21 In IDEA which functions should be used to find repeated values ? Detection Exclude 
Sequence 

checking 
Filter A 

ACA22 
In IDEA, Stratification functions can be applied on which type of 

data ? 
Numeric Data Date Data Character Data All of the above D 

ACA23 
In IDEA,Summarization accumulates the values of Numeric fields 

for each  . 
Primary Key Unique Key Secondary Key Composite Key B 

ACA24 
In which sampling,selecting sampling units using a fixed interval 

between selections is  . 
Random Systematic All of the above 

None of the 

above 
B 

 
ACA25 

Ensures that all combinations of sampling units in the population 

have an equal chance of selection is  . 

 
Random 

 
Systematic 

 
All of the above 

None of the 

above 
A 

ACA26 
In Audit tool, to built relation between two tables, both table 

should have  . 
Common Table Common Field Common record 

None of the 

above 
B 

ACA27 Input Control method is a part of Application Control Group. TRUE FALSE   A 

ACA28 
Which is the following type of check that can be run when data is 

input through terminal ? 
Field check Filter check Compare check Data check A 

ACA29 
Which is the following is the correct types of Field checks on 

processed data ? 
Overflow Range Sign Test All of the above D 

ACA30 
Which is the following is the correct types of Record checks on 

input data ? 
Resonableness Compare Un-compare Randomness A 

ACA31 Which is the correct types of Batch Checks ? Control Totals Outdated checks 
On-line dated 

checked 

Mixed dated 

checks 
A 

 
ACA32 

 
Which is the need for table level tests ? 

 
Data Integrity 

Controls are 

required for 

authorization 

 
Both A and B 

None of the 

above 
C 
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ACA33 

 

 
 

Which is the following is the major points with respect to inter 

table tests ? 

This may make 

the entire child 

tables referenced 

by the master 

field in the main 

table un- 

available 

 
Their Master & 

Child relationship 

reference the 

table from one 

another 

 

 

 
Both A and B 

 

 
 

None of the 

above 

 

 

C 

 
ACA34 

Which is the software used by the auditor to take a view of a file 

of data or transaction passing through the system at a particular 

point of time ? 

 
Mapping 

 
Snapshots 

 
Modelling 

Source 

comparison 
B 

ACA35 
Which is the software used by the auditor to compare the source 

version of a program with a secure master copy ? 

Souce 

comparison 
Code compasion 

Model 

comparison 
Exe comparison A 

 
ACA36 

Which is the techniques whereby the auditor arranges or 

manipulates data either real or fictitious, in order to see that a 

specific program or screen edit test is doing its work ? 

 
Debug Testing 

 
Logic Testing 

 
Off-line Testing 

 
On-line Testing D 

ACA37 
Which is the software used by the auditor to list un-used 

program instruction ? 
Log Analysis Mapping Program Library All of the above B 

ACA38 
Which is the software used by auditor to read and analyze 

records of machine activity ? 
Machine level Executable level 

Log Analyzers 

Software 
Systax level C 

ACA39 
Which of the following reason strongly call for Control & Audit 

Function ? 

Lack of Visible 

Transaction Trail 

Absence of Input 

Document 
All of the above 

None of the 

above 
C 

ACA40 Which is the correct types of Field checks on input data ? Missing data Blank data Both type 
None of the 

above 
C 

 

 
ACA41 

 

Which is the major points to be consider with respect to System 

tests ? 

To ensure the 

input data is valid 

before entering 

the value 

Test whether the 

overall system 

meet the 

requirement 

specifications 

To ensure the 

entered data is 

saved without 

fail 

 

 
All of the above 

 

A 

ACA42 
In Data analysis techniques, which law is used to idenfity 

statistical report on numeric data ? 
Bend Law Benjamin law Benford Law British Law C 

ACA43 
Which is not a feature of File reorganization with an auditor 

perspective? 
Filtering Sorting Indexing 

Linking the 

identified files 
A 
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ACA44 

 

What do you understand by the term, “Data Consistency” in 

using CAATs? 

Establish 

relationship 

between two or 

more tables as 

required. 

 
Identify fields, 

which have null 

values. 

Identify data, 

which are not in 

agreement with 

the regular 

format. 

 
Identify whether 

all fields have 

valid data. 

 

C 

 
ACA45 

Functions involving use of arithmetic operators, which enable 

performing re-computations and re-performance of results is an 

example of? 

Statistical 

function 

Arithmetic 

function 

 
Logical function 

Relational 

function 
B 
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